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Кратко о LTspice

LTspice — инструмент моделирования схем

в SwitcherCAD III. Это программа моделиро-

вания схем с поддержкой рисования. LTspice-

симулятор первоначально базировался на

Berkeley SPICE 3F4/5. Симулятор претерпел

полную переработку с целью улучшения ра-

боты, обнаружения ошибок и доведен до со-

стояния промышленного стандарта в полу-

проводниковых и поведенческих моделях.

Наряду с расширением возможностей анало-

гового SPICE-моделирования добавлена воз-

можность цифрового моделирования, чтобы

сделать LTspice симулятором аналогового

и смешанного моделирования промышлен-

ного уровня для большого класса схем им-

пульсных регуляторов и фильтров на пере-

ключаемых конденсаторах.

Многие продукты Linear Technology смо-

делированы с использованием составляющих

собственность блоков и (или) составляющих

собственность языка, которые объединяют

реалистичное поведение с традиционными

макромоделями. Это дает возможность быс-

тро смоделировать систему питания и изго-

товить прототип.

LTspice может использоваться как SPICE-

симулятор схем общего назначения. Новые

схемы можно создать с использованием под-

ключенной программы рисования. Команды

моделирования и параметры помещаются на

схему как текст с использованием синтакси-

са SPICE. Щелчком мыши на цепи схемы

в процессе моделирования или после моде-

лирования на экран выводятся графики на-

пряжений и токов.

LTspice — зарегистрированная торговая

марка Linear Technology Corporation.

Описание схемы

Схемы описываются текстом списка соеди-

нений (netlist). Список соединений состоит

из списка элементов схемы и их узлов, опре-

делений моделей и других SPICE-команд.

Обычно список соединений формируется

при графическом вводе схемы. Чтобы начать

новую схему, выберите в меню File>Open.

Появится окно файлового браузера. Выбери-

те любую имеющуюся схему и сохраните ее

под новым именем или создайте новый чис-

тый файл схемы под новым именем. LTspice

использует различные типы файлов и доку-

ментов. Описание схемы сохраняется в фай-

ле с расширением .asc. Команды рисования

схемы находятся в меню Edit. Клавиши бы-

строго вызова показаны в списке команд ре-

дактора схем.

Когда схема моделируется, информация

для списка соединений извлекается из графи-

ческой информации для создания файла

с именем схемы, но с расширением .net.

LTspice читает его как netlist.

Можно также открывать, моделировать

и редактировать текстовый список соедине-

ний, созданный вручную или сгенерирован-

ный извне. Файлы с расширениями .net, .cir

и .sp распознаются LTspice как список соеди-

нений.

Общая структура и соглашения

Анализируемая схема описывается текс-

товым файлом, называемым списком со-

единений. Первая строка в списке соедине-

ний игнорируется, так как по предположе-

нию является комментарием. Последняя

строка списка соединений обычно просто

строка .END, но она может быть опущена.

Любые строки после строки .END игнори-

руются.

Порядок строк между комментарием и кон-

цом не регламентирован. Строки могут быть

комментариями, параметрами элементов схе-

мы или директивами моделирования. Нач-

нем с примера:

* Первая строка игнорируется

* Схема представляет собой резистивно-емкостной фильтр

* с входным сигналом прямоугольной формы 1 МГц

R1 n1 n2 1К; резистор 1 кОм между узлами n1 и n2

C1 n2 0 100p; конденсатор 100 пФ между узлами n2 и «землей»

V1 n1 0 PULSE(0 1 0 0 0 .5μ 1μ); прямоугольный сигнал 1 МГц

.tran 3μ; анализ переходного процесса продолжительностью 3 мкс

.end

Первые две строки — комментарии. Любая

строка, начинающаяся с «*», является ком-

ментарием и игнорируется. Строка, начина-

ющаяся с «R1», объявляет, что есть резистор

сопротивлением 1 кОм, включенный между

узлами n1 и n2. Отметим, что при этом мо-

жет использоваться точка с запятой «;», что-

бы начать комментарий в середине строки.

Строка, начинающаяся с «C1», объявляет, что

есть конденсатор емкостью 100 пФ между уз-

лом n2 и «землей». Узел «0» — глобальная

«земля» схемы.

Случайные знаки, пробелы и табуляции

игнорируются.

Первый отличный от пробела знак в стро-

ке (табл. 6) определяет тип элемента схемы.

Числа могут быть выражены не только в на-

учном написании, например, 1e12, но и с ис-

В этой части статьи рассмотрены синтаксис языка LTspice и директивы

моделирования.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008

Таблица 6. Первый символ в строке

Таблица 7. Масштабные коэффициенты

Продолжение предыдущей строки. 
«+» не учитывается и продолжение строки считают

частью предшествующей строки

Директива моделирования, например: 
.options reltol=1e/4

Полевой транзистор с затвором Шоттки (MESFET)

Макромодель

Ключ, управляемый током

Независимый источник напряжения

Распределенная RC/цепь

Линия передачи без потерь

Ключ, управляемый напряжением

Резистор

Биполярный транзистор

Линия передачи с потерями

МОП/транзистор (MOS)

Индуктивность

Взаимная индуктивность

Полевой транзистор 
с управляющим p�n/переходом (JFET)

Независимый источник тока

Источник напряжения, управляемый током

Источник тока, управляемый напряжением

Источник тока, управляемый током

Источник напряжения, управляемый напряжением

Диод

Конденсатор

Источник с произвольным поведением

Устройство со специальными функциями
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пользованием инженерных множителей.

Таким образом, 1000 или 1e3 может также

быть записано как 1 К. В таблице 7 перечис-

лены масштабные коэффициенты.

Не специфицированные буквы, следую-

щие после числа или инженерного множи-

теля, игнорируются. Следовательно, 10, 10 V,

10 Volts и 10 Hz представляют одно и то же

число, и М, MA, МSec и MMhos представ-

ляют один и тот же масштабный коэффи-

циент (0,001). Распространенная ошибка

состоит в изображении резистора со значе-

нием сопротивления 1M, подразумевая ре-

зистор в один мегаом, однако, 1M интер-

претируется как резистор с сопротивлени-

ем один миллиом. Этим обеспечивается

совместимость со стандартными SPICE-пра-

вилами.

LTspice воспринимает числа, написанные

в форме 6K34, как 6,34 K. Это справедливо

для любого из перечисленных множителей.

Эта возможность может быть выключена сле-

дующим путем Tools>Control Panel>SPICE

с отключением Accept 3K4 as 3.4K.

Имена узлов могут быть произвольным

набором символов. Узел глобальной «земли»

схемы — «0», хотя есть и «GND» — специаль-

ный синоним. Поскольку узлы обозначают-

ся строкой символов, то «0» и «00» — разные

цепи.

Во всех последующих разделах угловые

скобки, помещенные вокруг полей данных,

должны быть заполнены соответствующей

информацией, например, <srcname> будет

именем некоего определенного источника.

Квадратные скобки указывают, что вложен-

ные в поле данные являются дополнитель-

ными и необязательными.

Синтаксис компонента

Компоненты, поддерживаемые в LTSpice,

и их синтаксис приведены в таблице 8.

Директивы моделирования. 
Команды с точкой

Для начала моделирования необходимо оп-

ределить не только схему, но и вид анализа,

который будет выполнен. Есть шесть различ-

ных типов анализа: линеаризованный анализ

на переменном токе в режиме малого сигна-

ла (linearized small signal AC), анализ на по-

стоянном токе со ступенчатым изменением

параметра (DC sweep), анализ шумов (noise),

расчет рабочей точки на постоянном токе

(DC operating point), нахождение передаточ-

ной функции на постоянном токе в режиме

малого сигнала (small signal DC transfer func-

tion) и анализ переходного процесса (tran-

sient analysis). Один из этих типов анализа

должен быть правильно описан.

Схема обычно изображается графически,

а команды помещаются в схему как текст. Все

такие команды начинаются с точки и поэто-

му названы «команды с точкой».

.AC — анализ на переменном токе

в режиме малого сигнала,

линеаризованный в окрестности

рабочей точки по постоянному току

(расчет частотных характеристик)

Для малых приращений сигнала (линей-

ных) на переменном токе LTspice вычисляет

комплексные значения узловых напряжений

и токов ветвей в функции частоты. Сначала

определяется рабочая точка схемы по посто-

янному току. Затем находятся линеаризован-

ные для малого сигнала модели всех нели-

нейных компонентов схемы в этой рабочей

точке. И, наконец, при использовании неза-

висимых источников напряжения и тока как

управляющие сигналы результирующая ли-

неаризованная схема обсчитывается в задан-

ном диапазоне частот.

Этот метод применяется при анализе филь-

тров и цепей, устойчивости и шумов.

Синтаксис:

.ac <oct, dec, lin> <количество точек> <начальная частота> <ко-

нечная частота>

Частота изменяется от <начальной часто-

ты> до <конечной частоты>. Ключевые сло-

ва oct, dec устанавливают логарифмический

характер изменения частоты октавами и де-

кадами соответственно, lin — линейное из-

менение частоты. Ключевое слово <количе-

ство точек> определяет количество точек на

октаву, декаду или весь диапазон частот.

Директива .AC вносится в лист схемы по ко-

манде Edit>SPICE Analysis с последующим вы-

бором в диалоговом окне пункта AC Analysis

и заполнением ячеек соответственно заданию.

Диалоговое окно показано на рис. 31.

Один из примеров анализа на переменном

токе содержится в файле …LTC\SwCADIII\ex-

amples\Educational\phono.asc.

.BACKANNO — связь имен выводов

макромодели с токами портов

Синтаксис:

.backanno

Эта директива автоматически включается

в каждый список соединений, генерируемый

SwitcherCAD III из схемы. Она заставляет

LTspice включить в .raw файл информацию

о связи токов портов с именами выводов. Это

www.kit5e.ru

Таблица 8. Синтаксис компонентов

Zxx <узел стока> <узел затвора> <узел истока> <имя модели> 
[коэффициент кратности area] [проводимость]  [IC=<Vds,Vgs>]

Xxx n1 n2 n3… <имя макромодели>

Wxx <узел1> <узел2> <имя управляющей ветви> <модель> 
[сопротивление замкнутого ключа, сопротивление разомкнутого ключа]

Vxx <+узел> <–узел> <значение напряжения>

Uxx <узел1> <узел2> <узел общий>  <имя модели>  L=< длина, м> 
[N=<количество сегментов>]

Txx <+узел порта L><–узел порта L>
<+узел порта R><–узел порта R>
ZO=<значение> TD=<значение>

Sxx <узел1> <узел2> <+управляющий узел>  <–управляющий узел> <имя модели>
[сопротивление замкнутого ключа, сопротивление разомкнутого ключа]

Rxx <узел1> <узел2> <сопротивление> [дополнительные параметры]

Qxx <узел коллектора> <узел базы> <узел эмиттера>  [узел подложки] 
<имя модели>  [коэффициент кратности area]  [проводимость]

[IC=Vbe,Vce][temp=<температура>]

Oxx <+узел порта L> <–узел порта L> <+узел порта R> <–узел порта R> <имя модели>

Mxx <узел стока> <узел затвора> <узел истока> <узел подложки> <имя модели>
[L=<длина канала>]  [W=<ширина канала>] [AD=<площадь стока>]  

[AS=<площадь истока>] [PD=<периметр стока>]  [PS=<периметр истока>] [NRD=<значение>]
[NRS=<значение>] [проводимость]  [IC=<Vds, Vgs, Vbs>]  [temp=<температура>]

Lxx <+узел> <–узел> <индуктивность> [ic=<начальный ток>] [Rser=<значение>]
[Rpar=<значение>]  [Cpar=<значение>] [m=<значение>] [дополнительные параметры]

Kxx L1 L2 L3… <коэффициент связи>

Jxx <узел стока> <узел затвора> <узел истока> <имя модели> 
[коэффициент кратности area] [проводимость] [IC=<Vds,Vgs>] [temp=<температура>]

Ixx <+узел> <–узел> <значение тока>

Hxx <+узел> <–узел> <имя управляющего источника напряжения> <коэффициент передачи>

Gxx <+узел> <–узел> <+управляющий узел>  
<–управляющий узел> <коэффициент передачи>

Fxx <+узел> <–узел> <имя управляющего источника напряжения> <коэффициент передачи>

Exx <+узел> <–узел> <+управляющий узел>  
</управляющий узел> <коэффициент передачи>

Dxx <узел анода> <узел катода <имя модели> [коэффициент кратности area]

Cxx <+узел> <–узел> <емкость> [ic=<начальное напряжение>] [Rser=<значение>]
[Lser=<значение>] [Rpar=<значение>] [Cpar=<значение>]

[m=<значение>] [дополнительные параметры]

Bxx <+узел> <–узел> <V=… или I=…>

Полевой транзистор 
с затвором Шоттки (MESFET)

Макромодель

Ключ, управляемый током

Независимый источник напряжения

Однородная RC/линия 
с распределеными параметрами

Линия передачи без потерь

Ключ, управляемый напряжением

Резистор

Биполярный транзистор

Линия передачи с потерями

МОП/транзистор (MOSFET)

Индуктивность

Взаимная индуктивность

Полевой транзистор 
с управляющим p�n/переходом (JFET)

Независимый источник тока

Источник напряжения, управляемый током

Источник тока, управляемый напряжением

Источник тока, управляемый током

Источник напряжения, 
управляемый напряжением

Диод

Конденсатор

Источник с произвольным поведением

Axx <узел 1> <узел 2> <узел 3> <узел 4> <узел 5> <узел 6> <узел 7> <узел 8> 
<имя модели> [дополнительные параметры]

Устройство со специальными функциями

Рис. 31. Задание параметров .AC/анализа
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позволяет отображать ток через вывод ком-

понента щелчком мыши на выводе компо-

нента.

.DC — анализ режима 

по постоянному току 

с вариацией параметров источников

По этой директиве выполняется анализ по

постоянному току со ступенчатым изменени-

ем параметра источника постоянного напря-

жения или тока. Одновременно может быть

использовано до трех источников. Директи-

ва, в частности, применяется для вычисления

передаточной функции усилителя по посто-

янному току или отображения характерис-

тик для проверки модели транзистора.

Синтаксис:

.dc < имя 1-го источника> < начальное значение> <конечное зна-

чение> < приращение> [<имя 2-го источника> < начальное зна-

чение> <конечное значение> < приращение>]

<Имя источника> — имя независимого ис-

точника напряжения или тока, выходной сиг-

нал которого задается ступенями <прираще-

ние> от <начального значения> до <конеч-

ного значения>.

Это не документировано разработчиком,

но возможно в качестве одного из источни-

ков указывать температуру. При вариации

температуры в качестве имени источника ука-

зывается ключевое слово TEMP.

Параметры моделирования задаются с ис-

пользованием диалогового окна, вызывае-

мого по команде меню Edit>SPICE Analysis

с выбором пункта DC sweep, показанного

на рис. 32.

Для каждого от одного до трех независи-

мых источников необходимо указать его имя,

характер изменения его выходного сигнала

(линейный, логарифмический на октаву или

декаду, задаваемый в виде списка значений),

начальное и конечное значения, шаг измене-

ния или количество точек.

В качестве выходного сигнала выступают

разность узловых потенциалов или ток через

ветвь с включенным в нее резистором.

В файле …LTC\SwCADIII\examples\Educa-

tional\ stepmodelparam.asc показан пример ис-

пользования .DC-директивы для демонстра-

ции выходных характеристик биполярного

транзистора.

.END — конец списка соединений

Эта директива отмечает конец текстово-

го списка соединений. Все строки после нее

игнорируются. Не нужно помещать дирек-

тиву как текст на схеме, поскольку экстрак-

тор списка соединений делает это самосто-

ятельно.

.ENDS — конец описания макромодели

Синтаксис:

.ends [имя макромодели]

Эта директива отмечает конец описания

макромодели. (См. .SUBCKT для дополни-

тельной информации.) Необязательный па-

раметр [имя макромодели] используется

для удобства чтения и анализа текстового

файла.

.FOUR — вычисление 

Фурье-компонентов 

после .TRAN-анализа

Синтаксис:

.four <частота первой гармоники> [количество гармоник] [коли-

чество периодов] <выходные данные 1> [<выходные данные 2> ...]

Например: 

.four 1kHz V(out)

Эта команда выполняется после анализа

переходного процесса. Результат выполне-

ния команды печатается в файл .log. Для про-

смотра результата используется команда ме-

ню View>Spice Error Log. В большинстве слу-

чаев для быстрого преобразования Фурье

лучше воспользоваться возможностями ок-

на графиков по команде меню View>FFT.

Задается частота первой гармоники и ко-

личество анализируемых гармоник. По умол-

чанию рассчитываются первые 9 гармоник.

Фурье-анализ выполняется на отрезке вре-

мени, отстоящем от конечного времени, Tend,

более чем на период, по меньшей мере, на один

период, если после количества гармоник ука-

зано количество периодов. Если количество

периодов задано равным –1, Фурье-анализ вы-

полняется по всему временному отрезку.

Пример использования директивы .FOUR

приведен в файле …LTC\SwCADIII\exam-

ples\Educational\audioamp.asc.

.FUNC — функции, 

определяемые пользователем

Синтаксис:

.func <имя>([аргументы]) {<выражение>}

Например: 

.func Pythag(x,y) {sqrt(x*x+y*y)}

Директива .FUNC позволяет создание поль-

зовательских функций для использования

в собственных параметризованных схемах

и поведенческих источниках. Этим обеспе-

чивается понятная ассоциативная связь име-

ни с функцией и параметризованной макро-

моделью, чтобы абстрактные схемы можно

было сохранить в библиотеках.

Директива .FUNC может быть включена

в описание макромодели, чтобы ограничить

использование функции этой макромоделью

и макромоделями, входящими в нее.

Чтобы вводить параметр и оценивать вы-

ражение пользовательской функции, выра-

жение заключается в фигурные скобки. Вло-

женное выражение будет заменено числом

с плавающей точкой.

Пример использования директив .FUNC

и .PARAM:

* Example deck using a .func statement

.func myfunc(x,y) {sqrt(x*x+y*y)}

.param u=100 v=600

V1 a 0 pulse(0 1 0 1n 1n .5μ 1μ)

R1 a b {myfunc(u,v/3)}

C1 b 0 100p

.tran 3μ

.end

Подстановка параметров делается до нача-

ла моделирования.

.FERRET — загрузка файла данных 

с использованием URL

Эта команда позволяет загружать файлы

пакетным способом, указывая URL. Это удоб-

но, когда не хочется указывать пути к каждо-

му файлу через интернет-браузер. Загружен-

ный файл будет в том же каталоге, что и ис-

ходная схема или список соединений. Эта

команда не имеет никакого воздействия на

моделирование:

* example deck

.ferret http://ltspice.linear.com/software/scad3.pdf

.end

.GLOBAL — 

назначение глобальных узлов

Синтаксис:

.global <узел1> [узел2 [узел3] [...]]

Например: 

.global VDD VCC

Команда .GLOBAL позволяет объявить, что

определенные узлы, упомянутые в макромо-

делях, не локальные для макромодели узлы,

а абсолютно глобальные узлы.

Рис. 32. Задание параметров .DC/анализа
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Общим глобальным для схемы является

узел «0», для этого не требуется использовать

директиву .GLOBAL. Узлы с именами в фор-

ме «$G_» также являются глобальными без

упоминания в директиве .GLOBAL.

.IC — задание начальных условий

Директива .IC задает начальные условия

для анализа переходных процессов. Могут

быть заданы узловые напряжения и токи че-

рез катушки индуктивности. Решение для по-

стоянного тока выполняется с использовани-

ем начальных условий как ограничений. Ес-

ли катушки индуктивности в решении для

постоянного тока в других SPICE-програм-

мах обычно рассматриваются коротко замк-

нутыми, в LTspice, если начальный ток опре-

делен, они рассматриваются как источники

тока бесконечного импеданса.

Синтаксис:

.ic [V(<узел>)=<напряжение>] [I(<катушка>)=<ток>]

Например: 

.ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m

.INCLUDE — 

подключение текстовых файлов

Синтаксис:

.include <имя файла>

Эта директива подключает названный

файл, как будто этот файл напечатан в спи-

ске соединений вместо команды .INCLUDE.

Она используется для подключения библио-

тек моделей или макромоделей.

В имени файла должен быть указан пол-

ный путь к нему. Иначе LTspice смотрит сна-

чала в каталоге <SwCADIII>\lib\sub, а затем

в каталоге, который содержит запрашивае-

мый список соединений, где <SwCADIII> —

каталог, содержащий исполняемый scad3.exe,

типично устанавливается как C:\Program

Files\LTC\SwCADIII.

Недопустимо игнорировать расширение

имени файла. Следует использовать .inc my-

file.lib, а не .inc myfile, если файл называет-

ся myfile.lib.

Можно определить url как имя файла сле-

дующим образом:

.inc http://www.company.com/models/library.lib

Файл library.lib будет передан в каталог схемы

и подключен. Во избежание повторной загруз-

ки файла при следующем сеансе моделирова-

ния можно отредактировать директиву .INC.

.inc library.lib

Отметим, что если запрашиваемый url не

существует, большинство серверов сети не

показывают ошибку, но показывают html

web-страницу в вашем web-браузере, кото-

рая объясняет ошибку. LTspice может не все-

гда воспринимать эти страницы как указание

на ошибку, таким образом, можно получить

некое загадочное сообщение об ошибке, ког-

да идет процесс моделирования с включени-

ем html web-страницы как директивы SPICE.

Если полученный документ представляет

собой .pdf-файл, моделирование прервется

после загрузки. Например, после загрузки

файла .pdf будет получен следующий ком-

ментарий:

* Dummy simulation to download the help file.

* The simulation will abort with an error, but

* you'll be left with the file scad3.pdf in the

* same directory containing the netlist.

.inc http://ltspice.linear.com/software/scad3.pdf

.end

Директива .INCLUDE использована в при-

мере …LTC\SwCADIII\examples\Educational\

logamp.asc для подключения макромодели

компонента opamp, в атрибутах которого нет

указания на имя макромодели или файл, ее

содержащий.

.LIB — подключение библиотеки

Синтаксис:

.lib <имя файла>

Эта директива подключает модель и опи-

сание макромодели в названном файле, как

будто этот файл напечатан в списке соедине-

ний вместо команды .lib. Если модель (моде-

ли) компонентов в подключаемом файле

имеет альтернативные описания в библиоте-

ке LTSpice, то последние игнорируются.

В имени файла должен быть указан пол-

ный путь к нему. Иначе LTspice смотрит сна-

чала в каталоге <SwCADIII>\lib\sub, а затем

в каталоге, который содержит запрашивае-

мый список соединений, где <SwCADIII> —

каталог, содержащий исполняемый scad3.exe,

типично устанавливается как C:\Program Files\

LTC\SwCADIII.

Недопустимо игнорировать расширение име-

ни файла. Необходимо указать .lib myfile.lib,

а не .lib myfile, если файл называется myfile.lib

Можно определить url как имя файла сле-

дующим образом:

.lib http://www.company.com/models/library.mod

Файл library.mod будет передан в каталог схе-

мы и подключен. Во избежание повторной за-

грузки файла при следующем сеансе модели-

рования можно отредактировать указание .lib:

.lib library.mod

Зашифрованные библиотеки

LTspice может генерировать и читать библио-

теки, зашифрованные в специальной форме.

Это позволяет одному пользователю готовить

библиотеку для другого пользователя, кото-

рую можно использовать в моделировании,

не показывая ее содержимое. Резонно попы-

таться сделать зашифрованную библиотеку,

которую исключительно сложно расшифро-

вывать, но такое решение нельзя считать аб-

солютным, если только не решить проблему

непосредственно в программном обеспечении.

Чтобы подготовить зашифрованную биб-

лиотеку, нужно вызвать LTspice из команд-

ной строки с выбором опции «-encrypt». Сна-

чала следует сделать копию библиотеки, по-

скольку она будет заменена зашифрованной

версией. Нет никакой возможности преобра-

зовать зашифрованную библиотеку обратно

в текстовый формат. Уточним эти два шага:

1. Сделайте резервные копии библиотеки.

Версия, которая кодируется, будет удалена.

2. В командной строке напечатайте:

scad3.exe -encrypt <filename>

Файл <filename> будет заменен зашифро-

ванной версией. Процесс шифрования зай-

мет несколько минут.

По окончании этого процесса вы будете

иметь зашифрованный ASCII-файл. Можно

добавить уведомление об авторском праве вы-

ше строки «*Begin:», но первые 9 строк файла

должны остаться неизменными, и каждая стро-

ка уведомления об авторском праве, добавлен-

ная вами, должна начинаться символом «*».

Итак, приведем пример зашифрованного

файла, созданный LTspice:

* LTspice Encrypted File

*

* This encrypted file has been supplied by a 3rd

* party vendor that does not wish to publicize

* the technology used to implement this library.

*

* Permission is granted to use this file for

* simulations but not to reverse engineer its

* contents.

*

* Begin:

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B

FB FE 1D...

Можете изменить файл следующим образом:

* LTspice Encrypted File
*
* This encrypted file has been supplied by a 3rd
* party vendor that does not wish to publicize
* the technology used to implement this library.
*
* Permission is granted to use this file for
* simulations but not to reverse engineer its
* contents.
*
* Copyright © 2005 Acme SPICE Modeling
* For additional information, see
* www.acmespicemodels.com
*
* Begin:
50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24
36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B
FB FE 1D...

www.kit5e.ru
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.LOADBIAS — загрузка 

предварительно выполненного расчета

по постоянному току

Синтаксис:

.loadbias <имя файла>

Команда LOADBIAS — дополнение к коман-

де .SAVEBIAS. Сначала выполните моделиро-

вание по команде .SAVEBIAS. Затем измените

команду .SAVEBIAS на команду .LOADBIAS.

.MEASURE — измерение заданных 

пользователем электрических величин

Есть два различных варианта директив

.MEASURE. В первом случае обращаются

к точке на оси абсцисс (независимая перемен-

ная, откладываемая по горизонтальной оси,

ось времени для .TRAN-анализа), во втором

случае обращаются к диапазону по оси абсцисс.

Первый вариант используется, чтобы найти

значение данных или выражения в заданной

точке на оси абсцисс, или когда выполняет-

ся необходимое условие. Используется сле-

дующий синтаксис:

.meas[sure] [AC|DC|OP|TRAN|TF|NOISE] <имя результата>
[<FIND|DERIV|PARAM> <выражение>] [WHEN <выражение> |
AT=<выражение>]] [TD = <значение1>] [<RISE|FALL|CROSS> =
[<отсчет1> |LAST]]

Здесь [AC|DC|OP|TRAN|TF|NOISE] — вид

анализа, к которому применяется директива;

FIND (найти); DERIV (производная); PARAM

(использование результатов предшествую-

щих измерений); WHEN (условие); AT (ко-

ордината точки измерения на оси абсцисс);

TD (задержка в единицах измерения по оси

абсцисс относительно момента выполнения

условия); RISE (увеличение); FALL (умень-

шение); CROSS (пересечение); LAST (послед-

ний случай).

В первой позиции можно указать вид ана-

лиза, к которому применяется директива

.MEAS. Это позволяет использовать соответ-

ствующие директивы .MEAS только в опре-

деленных видах анализа. Обязательно следу-

ет присваивать имя результату, который мо-

жет быть использован в качестве параметра

в других директивах .MEAS. Далее — приме-

ры директивы .MEAS с обращением к одной

точке на оси абсцисс:

.MEAS TRAN res1 FIND V(out) AT=5m

Результат — значение V(out) для t = 5 мс,

именованный как res1.

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y)

Результат — значение выражения

V(out)*I(Vout), когда условие V(x)=3*V(y)

встречается в первый раз. Он будет именован

как res2.

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3

Результат — значение V(out), когда усло-

вие V(x)=3*V(y) встречается в третий раз.

Он будет именован как res3.

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last

Результат — значение V(out), для которо-

го условие V(x)=3*V(y) встречается в послед-

ний раз, либо когда V(x) максимально близ-

ко к 3*V (y). Он будет именован как res4.

.MEAS TRAN res5 FIND V(out) WHEN V(x)=3*V(y) cross=3 TD=1m

Результат — значение V(out) через 1 мс по-

сле того, как условие V(x)=3*V(y) встречает-

ся в третий раз. Он будет именован как res5.

.MEAS TRAN res6 PARAM 3*res1/res2

Результат — значение 3*res1/res2. Такая

форма используется, чтобы определить зна-

чение выражения, составленного из резуль-

татов других .MEAS-утверждений. Не пред-

полагается, что в оцениваемом выражении

присутствуют непосредственные результаты

моделирования, например, V(3), если только

это не данные из последней точки моделиро-

вания. Результат именован как res6.

В приведенных примерах обращения к од-

ной точке на оси абсцисс результат соответ-

ствует данным ординаты (зависимые пере-

менные). Если информация об ординате не

требуется, результатом .MEAS-утверждения

будет точка на оси абсцисс, в которой выпол-

няется условие измерений:

.MEAS TRAN res6 WHEN V(x)=3*V(y)

Результат — это момент времени, когда

условие V(x)=3*V(y) встречается впервые.

Он именован как res6.

Второй вариант директивы .MEAS обраща-

ется к диапазону по абсциссе. Используется

следующий синтаксис:

.meas [AC|DC|OP|TRAN|TF|NOISE] <имя результата>

[<AVG|MAX|MIN|PP|RMS|INTEG> <выражение>] [TRIG <lhs1>

[[VAL] =] <rhs1>] [TD = <значение1>] [<RISE|FALL|CROSS> =

<отсчет1>] [TARG <lhs2> [[VAL] =] <rhs2>] [TD = <значение2>]

[<RISE|FALL|CROSS> = <отсчет2>]

Диапазон по абсциссе ограничен точками,

определенными как «TRIG» и «TARG».

По умолчанию точка TRIG устанавливает на-

чало моделирования и может быть опущена.

Точно так же точка TARG по умолчанию со-

ответствует данным в конце моделирования.

Если все три из TRIG, TARG и WHEN точки

опущены, то утверждение .MEAS действует

на весь диапазон данных. Типы измерений,

которые могут быть выполнены в интерва-

ле, перечислены в таблице 9.

Если никакое измерение не задано, резуль-

тат директивы .MEAS — расстояние по абс-

циссе между точками TRIG и TARG. Далее —

пример директивы .MEAS по диапазону:

.MEAS TRAN res7 AVG V(NS01) TRIG V(NS05) VAL=1.5 TD=1.1u

FALL=1 TARG V(NS03) VAL=1.5 TD=1.1u FALL=1

Результат — среднее значение напряжения

V(NS01) на отрезке времени от 1-го умень-

шения V(NS05) до 1,5 В с задержкой 1,1 мкс

и до 1-го уменьшения V (NS03) до 1,5 В с за-

держкой 1,1 мкс. Результат именован как res7.

Для .AC-анализа условные выражения

в комплексных данных упрощаются до ве-

щественной части с преобразованием в вы-

ражение для амплитуды. Например:

.MEAS AC res8 when V(out)=1/sqrt(2)

Результат res8 — частота, на которой вели-

чина V(out) равна 0.7071067811865475.

Кроме того, результат директивы .MEAS

может использоваться в другой директиве

.MEAS. В следующем примере рассчитана по-

лоса пропускания на уровне 3 дБ:

.MEAS AC tmp max mag(V(out)); найдем амплитуду и запомним

как tmp

.MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1 targ

mag(V(out))=tmp/sqrt(2) fall=last

Результат — разность частот между двумя

точками, лежащими на 3 дБ ниже максималь-

ного значения сигнала. Отметим, что данные,

получаемые в .AC-анализе, комплексные, и та-

ковы же результаты по директиве .MEASURE.

Тем не менее, равенство оперирует только

с реальной частью комплексного числа, то есть

выражение mag(V(out))=tmp/sqrt(2) эквива-

лентно Re(mag(V(out)))=Re(tmp/sqrt(2)).

Операции AVG, RMS и INTEG в .NOISE-

анализе несколько иные, чем в анализах дру-

гих типов, так как .NOISE связан с квадратом

частоты. Таким образом, и AVG, и RMS да-

ют среднеквадратичное напряжение шумов,

а INTEG дает интегрированный полный

шум. Следовательно, если вы добавляете

SPICE-директивы:

.MEAS NOISE out_totn INTEG V(onoise)

.MEAS NOISE in_totn INTEG V(inoise)

Таблица 9. Вычислительные операции,

выполняемые по диапазону данных

Интегрирование <выражение>

Вычисление среднеквадратичного значения 
<выражение>

Нахождение размаха от пика до пика <выражение>

Нахождение минимального значения <выражение>

Нахождение максимального значения <выражение>

INTEG

RMS

PP

MIN

MAX

Вычисление среднего значения <выражение>AVG

Выполняемая по диапазону операция
Ключевое

слово
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к .NOISE-анализу, в .log-файле будут напеча-

таны значения полных интегрированных

среднеквадратичных шумов, приведенных

к выходу и входу.

Директива .MEAS выполняется после окон-

чания моделирования. Это позволяет запи-

сывать сценарии директив .MEAS и выпол-

нять их над набором данных. Для этого сде-

лайте окно графиков активным и выполните

команду меню File>Execute .MEAS Script.

Другое последствие .MEAS-директив, выпол-

няемых после моделирования, — то, что точ-

ность вычислений ограничена точностью

данных графика после сжатия. Можно изме-

нить параметры настройки сжатия для полу-

чения более точных результатов по .MEAS-

директиве.

Не следует задавать условие в виде равен-

ства, типа «when <cond1> = <cond2>». Это

объясняется тем, что равенство чисел в фор-

ме с плавающей запятой никогда не должно

требоваться из-за конечной точности, исполь-

зуемой при хранении чисел.

Пример использования директивы .MEASURE

приведен в файле …LTC\SwCADIII\examples\

Educational\MeasureBW.asc.

.MODEL — определение SPICE-модели

Директива определяет модель для диода,

транзистора, ключа, линии передачи с поте-

рями или однородной RC-линии.

Некоторые элементы схемы, например,

транзисторы, имеют много параметров. Вме-

сто того чтобы определять каждый параметр

для каждого транзистора, транзисторы объ-

единены именем модели и имеют общие па-

раметры. Транзисторы одной модели могут

иметь различные размеры, и электрическое

поведение масштабируется в соответствии

с размером.

Синтаксис:

.model <имя модели> <имя типа модели> [(<список параметров>)]

Например: 

.model DIODE D (Is=1E-10)

Имя модели должно быть уникальным.

Таким образом, два различных типа элемен-

тов схемы, типа диода и транзистора, не мо-

гут иметь одного имени модели. Список па-

раметров зависит от ее типа. В таблице 10

приведен перечень типов моделей.

.NET — расчет параметров цепей 

в .AC-анализе

Эта директива используется при .AC-ана-

лизе в режиме малого сигнала, чтобы вычис-

лить входной и выходной адмиттанс, импе-

данс, Y-, Z-, H- и S-параметры четырехполюс-

ника. Эту методику можно также использовать

для вычисления входного адмиттанса и импе-

данса двухполюсника. Директива должна ис-

пользоваться с директивой .AC, определяю-

щей девиацию частоты при анализе цепи.

Синтаксис:

.net [V(out[,ref])|I(Rout)] <Vin|Iin> [Rin=<значение>]

[Rout=<значение>]

Входной порт цепи определяется либо не-

зависимым источником напряжения, <Vin>,

либо независимым источником тока, <Iin>.

Соответственно, выходной порт определяет-

ся либо как узел, V(out), либо как резистор,

I(Rout). К портам подключаются резисторы

Rin и Rout. Если не указано определенно, под-

ключаемые импедансы по умолчанию 1 Ом,

кроме случаев источника напряжения с оп-

ределенным Rser или выходного порта, оп-

ределенного как резистор. В этих двух случа-

ях подключаемые резисторы по умолчанию

являются импедансами устройства. Импедан-

сы подключаемых по директиве .NET уст-

ройств действительны только для вычисле-

ний по этой директиве, но не для узловых на-

пряжений и токов обычного .AC-анализа.

То есть директива .NET не навязывает под-

ключаемые к цепи импедансы при расчете

напряжений и токов в процессе .AC-анализа.

Файл примера — …\LTC\SwCADIII\examples\

Educational\S-param. Рекомендуется исполь-

зовать источник напряжения, V4, с установ-

кой требуемого импеданса источника Rser,

и резистор, Rout, подключенный к выходу,

с простой формой записи директивы .net

I(Rout) V4. При этом нет необходимости за-

давать значения Rin или Rout в директиве

.NET, достаточно задать характеристики уст-

ройств, подключенных к входу и выходу.

Доступ к графикам зависимостей малосиг-

нальных параметров по команде Plot Settings>

Visible Traces или View>Add Trace.

.NODESET — задание начального 

режима по постоянному току

Директива .NODESET устанавливает на-

чальные значения узловых потенциалов в ра-

бочей точке по постоянному току. Если схе-

ма имеет множество возможных состояний

по постоянному току, например, триггер,

процесс итерации решения по постоянному

току может никогда не сойтись. Директиву

.NODESET можно использовать, чтобы уста-

новить схему в то или иное состояние. В ос-

новном, после того как выполнен проход ре-

шения с напряжением, определенным в ди-

рективе .NODESET, ограничение удаляется

в последующих итерациях.

Синтаксис:

.nodeset V(узел1)=<напряжение> [V(узел2)=<напряжение [...]]

.NOISE — расчет 

спектральной плотности шумов

Синтаксис:

.noise V(<узел1>[,<узел2>]) <имя источника> <oct, dec, lin> <ко-

личество точек> <начальная частота> <конечная частота>

Это — анализ в частотной области, в кото-

ром вычисляются джонсоновский тепловой

шум, дробовый и фликкер-шумы. Выходные

данные — значения квадратного корня из

спектральной плотности шумов.

V(<узел1>[,<узел2>]) — участок цепи,

для которого вычисляется полный выходной

шум. Это может быть выражено как V (n1, n2),

чтобы представить напряжение между дву-

мя узлами. <Имя источника> — имя незави-

симого источника напряжения или тока,

к входу которого пересчитывается шум. Это

фиктивный не шумящий источник сигнала.

Параметры <oct, dec, lin>, <количество то-

чек>, <начальная частота> и <конечная час-

тота> определяют интересующий частотный

диапазон и разрешение таким же образом,

как и при использовании в директиве .AC.

Параметры анализа вводятся с помощью ди-

алогового окна (рис. 33), вызываемого по ко-

манде меню Edit>Spice Analysis, с выбором

пункта Noise.

График выходных данных V(onoise) — спе-

ктральная плотность шумового напряжения

в узле (узлах), определенных как выход в вы-

шеупомянутом синтаксисе. Если источник

входного сигнала — источник напряжения,

то график V(inoise) — приведенная к входу

плотность напряжения шумов. Если источ-

ник входного сигнала — источник тока,

то график inoise — шум, приведенный к то-

ку источника входного сигнала. Может быть

www.kit5e.ru

Таблица 10. Имена типов моделей компонентов

Мощный вертикальный МОП/транзистор 
по технологии двойной диффузии

Однородная RC/линия с распределенными параметрами

Ключ, управляемый напряжением

Биполярный p�n�p/транзистор

МОП/транзистор с каналом p/типа

MESFET с каналом p/типа

Полевой транзистор с каналом p/типа

Биполярный n�p�n/транзистор

МОП/транзистор с каналом n/типа

MESFET с каналом n/типа

Полевой транзистор с каналом n/типа

Линия передачи с потерями

Диод

VDMOS

URC

SW

PNP

PMOS

PMF

PJF

NPN

NMOS

NMF

NJF

LTRA

D

Ключ, управляемый токомCSW

Тип компонента
Имя типа 
модели

Рис. 33. Задание параметров .NOISE/анализа
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отображен шумовой вклад каждого компо-

нента. Эти вклады пересчитываются к выхо-

ду. Можно пересчитать их к входу, поделив

данные графика на усиление.

В окне графиков можно суммировать шу-

мы в полосе пропускания, нажав на имя со-

ответствующего графика правой кнопкой

мыши при нажатой клавише Ctrl.

Пример использования директивы .NOISE

приведен в файле …LTC\SwCADIII\examples\

Educational\noise.asc.

.OP — определение режима 

по постоянному току в рабочей точке

Выполняется решение для постоянного

тока с отключенными емкостями и корот-

ко замкнутыми индуктивностями. Обычно

решение для постоянного тока выполняет-

ся как часть другого анализа, чтобы найти

рабочую точку схемы. Используйте дирек-

тиву .OP, если нужно только найти рабо-

чую точку. Результаты появятся в диалого-

вом окне. Решение по постоянному току

появится в управляющей строке, если ука-

зать на узел или цепь с током после .OP-мо-

делирования.

В файле …\LTC\SwCADIII\examples\Educa-

tional\DcopPnt.asc приведен пример исполь-

зования директивы .OP.

.OPTIONS — установка 

параметров моделирования

Все доступные параметры моделирования

приведены в таблице 11.

.PARAM — параметры, 

определяемые пользователем

Директива .PARAM позволяет создавать

определяемые пользователем переменные.

Она обеспечивает понятную ассоциативную

связь имени с параметризованной макромо-

делью, чтобы абстрактные схемы можно бы-

ло сохранить в библиотеках.

Директива .PARAM может быть включена

в описание макромодели, чтобы ограничить

действие значения параметра этой макромо-

делью и макромоделями, включенными в эту

макромодель.

Для подстановки параметра в оцениваемое

выражение заключите выражение в фигур-

ные скобки. Вложенное выражение будет за-

менено величиной с плавающей точкой.

Далее приведен пример использования как

собственно директивы .PARAM, так и непо-

средственного ввода параметров в строке вы-

зываемой макромодели:

*

* This is the circuit definition

.params x=y y=z z=1k*tan(pi/4+.1)

X1 a b 0 divider top=x bot=z

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

* this is the definition of the subcircuit

.subckt divider n1 n2 n3

r1 n1 n2 {top}

r2 n2 n3 {bot}

.ends

*

.tran 3μ

.end

Доступные математические функции и опе-

рации собраны в таблицах 12, 13.

В файле …\LTC\SwCADIII\examples\Educa-

tional\Cohn.asc приведен пример использо-

вания директивы .PARAM.

.SAVE — ограничение количества 

сохраняемых данных

В процессе некоторых видов анализа, осо-

бенно при моделировании во временной об-

ласти, может быть сгенерирован большой

объем данных. Объем выходных данных мо-

жет быть ограничен при использовании ди-

рективы .SAVE, чтобы сохранить только оп-

ределенные интересующие узловые напря-

жения и токи в устройстве.

Синтаксис:

.save V(out) [V(in) [I(L1) [I(S2)]]] [dialogbox]

Директива .save I(Q2) сохраняет токи базы,

коллектора и эмиттера биполярного транзи-

стора Q2. Чтобы сохранить ток через один

вывод транзистора, следует указать Ic(Q2).

Чтобы сохранить данные графиков, соот-

ветствующих образцу, можно использовать

символы группировки «*» и «?». Например,

«.save V(*) Id(*)» позволит сохранить каждое

значение напряжения и каждое значение тока.

Если присутствует ключевое слово dialogbox,

то появляется диалоговое окно со списком

всех доступных по умолчанию узловых на-

пряжений и токов, позволяющее пользова-

Таблица 11. Параметры моделирования

Абсолютная погрешность при расчете напряжений

Представление в компактной форме информации о токах и напряжениях 
в длинных линиях с потерями

Установка погрешности анализа переходного процесса. 
Этот параметр — коэффициент, определяющий фактическую ошибку округления

Устанавливается в нуль, чтобы отменить проверку плавающих узлов, 
контуров источников напряжения и топологии витков трансформаторов

Номинальное значение температуры

По умолчанию температура элементов схемы, 
для которых не задано определенное значение температуры 

Количество тактов ожидания перед поиском установившегося режима

Относительная погрешность детектирования установившегося режима

Альтернативное имя для itl6

Алгоритм ступенчатого изменения параметра источника 

Относительная погрешность при расчете напряжений и токов

Количество точек данных в одном окне после сжатия. 
Устанавливается в нуль, чтобы отменить сжатие

Установка абсолютной погрешности по напряжению при сжатии графиков

Установка относительной погрешности при сжатии графиков

Установка абсолютной погрешности по току при сжатии графиков

Абсолютная величина элемента строки матрицы, необходимая для его выделения 
в качестве ведущего элемента

Относительная величина элемента строки матрицы, необходимая для его выделения
в качестве ведущего элемента

Исторически “numdgt” использовался для установки разрядности выходных данных.
В LTspice, если “numdgt” больше 6, для зависимых переменных данных используется

двойная точность

Переход к непосредственному управлению шагом gmin

Отключение вывода графиков в процессе моделирования

Установка ограничения для завершения подбора gmin

Минимальное сохраняемое количество тактов

Выбор метода численного интегрирования

Разрядность выходных данных для директивы  .MEASURE.

Формат комплексных чисел для результатов директивы .MEASURE. 
Один из возможных: “polar”, “cartesian” или “bode”

Максимальный шаг при анализе переходного процесса

Максимальное сохраняемое количество тактов

Устанавливается в нуль, чтобы предотвратить ступенчатое изменение параметра источника
при начальном решении по постоянному току

Максимальное количество итераций при переходе к следующему моменту времени
при анализе  переходного процесса 

Максимальное количество итераций при расчете передаточной функции по постоянному току

Максимальное количество итераций в расчете по постоянному току

Дополнительная проводимость, добавляемая к каждому узлу относительно «земли»

Устанавливается в нуль, чтобы предотвратить перебор параметра при начальном решении
по постоянному току

Проводимость, добавленная к каждому p�n/переходу для облегчения преобразований

Включение внешних источников тока в режим нагрузки

Преобразование в формат файла fastaccess  в конце моделирования

Используется при просмотре графиков. Перемещает позиции битов в графике

Ширина канала МОП/транзистора по умолчанию

Длина канала МОП/транзистора по умолчанию

Площадь истока МОП/транзистора по умолчанию

Площадь стока МОП/транзистора по умолчанию

Дополнительная емкость, 
добавляемая к каждому внутреннему узлу устройства относительно «земли»

Дополнительная емкость, добавляемая к каждому узлу относительно «земли»

Абсолютная погрешность расчета заряда

Используется при просмотре графиков. Задает режим сглаживания битовых переходов

1 мкВ

1

1

1

27 °С

27 °С

5

0,001

25

0

0,001

300

10 мкВ

0,0025

1 нА

1.00E/13

1.00E/03

6

false

false

1.00E/04

10

trap

6

bode

бескон.

бескон.

25

10

50

100

0

25

1.00E/12

false

false

0

100 мкм

100 мкм

0

0

cshunt

0

10 фК

нет

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

флаг

флаг

число

число

слово

число

слово

число

число

число

число

число

число

число

число

число

флаг

флаг

число

число

число

число

число

число

число

число

число

VNTOL

TRYTOCOMPACT

TRTOL

TOPOLOGYCHECK

TNOM

TEMP

STARTCLOCKS

SSTOL

SRCSTEPS

SRCSTEPMETHOD

RELTOL

PLOTWINSIZE

PLOTVNTOL

PLOTRELTOL

PLOTABSTOL

PIVTOL

PIVREL

NUMDGT

NOOPITER

NOMARCH

MINDELTAGMIN

MINCLOCKS

METHOD

MEASDGT

MEASCPLXFMT

MAXSTEP

MAXCLOCKS

ITL6

ITL4

ITL2

ITL1

GSHUNT

GMINSTEPS

GMIN

FLSGLOADS

FASTACCESS

DELAY

DEFW

DEFL

DEFAS

DEFAD

CSHUNTINTERN

CSHUNT

CHGTOL

BAUTRATE

Абсолютная погрешность расчета токов1 пАчислоABSTOL

Наименование
Значение 

по умолчанию
Тип 

данных
Параметр
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телю составить список сохраняемых данных.

Если список соединений был сгенерирован

из схемы, то, указав на выбранные ранее уз-

лы и устройства и нажав кнопку мыши, мож-

но отобразить графики в окне.

Если указать для сохранения только один

график, то после запуска процесса модели-

рования он будет отображаться в окне гра-

фиков по ходу процесса, если только не дез-

активирована ячейка Marching Waveforms

в окне Operation панели управления.

.SAVEBIAS — 

сохранение рабочей точки на диске

Синтаксис:

.savebias <имя файла> [internal] [temp=<значение>] [time=< зна-

чение > [repeat]] [step=< значение >] [DC1=< значение >] [DC2=<

значение >] [DC3=< значение >]

Это команда записи на диск текстового

файла, который при последующем модели-

ровании загружается командой .LOADBIAS.

Для схемы, имеющей сложный расчет режи-

ма по постоянному току в рабочей точке,

можно сохранить решение на диске, чтобы

сэкономить время на расчете режима по по-

стоянному току при последующих анализах.

Ключевое слово INTERNAL добавляется,

чтобы указать, что внутренние узловые по-

тенциалы некоторых устройств также долж-

ны быть сохранены с сохранением более пол-

ного решения по постоянному току.

Чтобы сохранить определенную рабочую

точку по постоянному току при расчете пе-

реходных процессов .TRAN, необходимо ука-

зать момент времени. Первое решение для

момента времени, следующего за указанным,

будет сохранено. Модификатор REPEAT за-

ставляет записывать решение по постоянно-

му току через каждый период после указан-

ного момента времени. В файл записывает-

ся только последнее решение по постоянному

току. Можно указать DC1, DC2 и DC3, что-

бы извлечь единственную рабочую точку из

.DC-анализа с вариацией параметров.

По директиве .SAVEBIAS записывается текс-

товый файл в формате директивы .NODESET.

Отметим, что директивы .NODESET — только

рекомендации для решения. Таким образом, вы-

числитель начнет повторять решение с узловы-

ми напряжениями, заданными в директиве

.NODESET, но продолжит повторять вычисле-

ния, пока не будет найдено правильное реше-

ние. Если нужно повторно запустить .TRAN-ре-

шение из рабочей точки по постоянному току,

можно изменить файл .NODESET на .IC, чтобы

принудить вычислитель начать решение с этой

рабочей точки по постоянному току.

Поскольку суммарное состояние всех реак-

тивностей схемы не сохраняется в .SAVEBIAS

файле, успешное решение в этой технике до-

стижимо не всегда.

.STEP — ступенчатое 

изменение параметра

Эта команда заставляет неоднократно вы-

полнять анализ, ступенчато изменяя темпера-

туру, параметр модели, глобальный параметр

или параметр независимого источника. Ступе-

ни могут быть линейными, логарифмически-

ми или определенными как список значений.

Например: 

.step oct v1 1 20 5

Ступенчатое изменение напряжения незави-

симого источника напряжения V1 от 1 до 20 В

с логарифмическим изменением ступеней

с 5 точками на октаву.

Например: 

.step I1 10u 100u 10u

Изменение тока независимого источника

тока I1 от 10 до 100 мкА с шагом 10 мкА.

Например: 

.step param RLOAD LIST 5 10 15

Трехкратное выполнение моделирования

с глобальным параметром Rload, равным 5,

10 и 15.

Например:

.step NPN 2N2222(VAF) 50 100 25

Ступенчатое изменение параметра VAF мо-

дели NPN от 50 до 100 с шагом 25.

Например: 

.step temp -55 125 10

Изменение температуры от –55 до 125 °C

с шагом 10 °C.

Вариации шага могут быть вложениями

глубиной до трех уровней.

Например: 

.step I1 10u 100u 10u temp list 25 100

Изменение тока независимого источника

тока I1 от 10 до 100 мкА с шагом 10 мкА при

двух значениях температуры: 25 и 100 °C.

.SUBCKT — описание макромодели

Для упрощения описания повторяющие-

ся схемы могут быть оформлены в виде ма-

кромоделей со своим описанием и использо-

www.kit5e.ru

Таблица 12. Математические функции Таблица 13. Математические операции

Случайные числа между –0,5 и 0,5 
с плавными переходами между значениями, 

даже более плавными, чем в random()

Функция ограничения: uramp(x)=x, 
если x> 0; uramp(x)=0, если x≤0 

Ступенчатая функция: u(x)=1, 
если x> 0; u(x)=0, если x≤0 

Гиперболический тангенс x

Тангенс x

Табличная зависимость функции от x.
Координаты точек (x, y) в виде таблицы,
в промежутках между точками линейная

аппроксимация

Действительная часть квадратного корня x,
например, sqrt(–1) возвращает 0, не 0,707107i

Гиперболический синус x

Синус x

Знак x

Ближайшее целое число к x

Функция, подобная rand(x), но с более
плавными переходами между значениями

Случайные числа между 0 и 1 
в зависимости от значения x

sgn(x)*abs(x)**y

abs(x)**y

Действительная часть x**y, например,
pow(–0.5,1.5) возвращает 0, а не 0,353553i

Минимальное из x или y 

Случайное число между x * (1+y) и x * (1–y)
с нормальным распределением

Максимальное из x или y 

Десятичный логарифм x

Альтернатива ln(x)

Натуральный логарифм x

x, если y<x<z; y, если x<y; z, если x>y

inv(x)=0, если x>0,5; inv(x)=1, если x≤0,5 

Округление x до целого числа

y, если x истинно, иначе z

Интеграл ∫x(t)

sqrt(x**2 + y**2)

Случайное число с распределением Гаусса
с сигмой x

Целое число, равное или меньше x

Случайное число между –x и x 
с нормальным распределением

То же самое, что и abs(x)

Экспоненциальная функция x

Задержка сигнала x на время y

Первая производная dx/dt

Гиперболический косинус x

Косинус x

Целое число, равное или большее x

Кубический корень из x

buf(x)=1, если x>0,5; buf(x)=0, если x≤0,5

Гиперболический арктангенс

Арктангенс (x/y)

Синоним для atan(x)

Арктангенс x

Гиперболический арксинус

Синоним для asin(x)

Действительная часть арксинуса x, 
например, asin(–5) возвращает –1.57080, 

а не –1.57080+2.29243i

Действительная часть acosh(x), например,
acosh(.5) возвращает 0, а не 1.0472i

Синоним для acos(x)

Действительная часть arcos(x), 
например, acos(–5) возвращает 3.14159, 

а не 3.14159+2.29243i

WHITE(x)

URAMP(x)

U(x)

TANH(x)

TAN(x)

TABLE(x,a,b,c,d,...)

SQRT(x)

SINH(x)

SIN(x)

SGN(x)

ROUND(x)  

RANDOM(x)

RAND(x)

PWRS(x, y)

PWR(x, y)

POW(x, y)

MIN(x,y)

MC(x,y)

MAX(x,y)

LOG10(x)

LOG(x)

LN(x)

LIMIT(x,y,z)

INV(x)

INT(x)

IF(x, y, z)

IDT(x)

HUPOT(x,y)

GAUSS(x)

FLOOR(x)

FLAT(x)

FABS(x)

EXP(x)

DELAY(x,y)

DDT(x)

COSH(x)

COS(x)

CEIL(x)

CBRT(x)

BUF(x)

ATANH(x)

ATAN2(y, x)

ARCTAN(x)

ATAN(x)

ASINH(x)

ARCSIN(x)

ASIN(x)

ACOSH(x)

ARCOS(x)

ACOS(x)

Абсолютное значение xABS(x)

ОпределениеФункция

Оператор выбора шага

Преобразование, эквивалентное логической инверсии

Возведение в степень, возвращается только действитель/
ная часть, например, –2**1,5 возвращает 0, а не 2,82843i

Деление с плавающей точкой

Умножение с плавающей точкой

Вычитание с плавающей точкой

Сложение с плавающей точкой

ИСТИНА (TRUE), если выражение слева меньше 
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше 
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева
меньше выражения справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева 
больше выражения справа, иначе ЛОЖЬ (FALSE)

Преобразование, эквивалентное логическому
исключающему ИЛИ (XOR)

Преобразование, эквивалентное логическому ИЛИ (OR)

@

!

**

/

*

–

+

<=

>=

<

>

^

|

Преобразование, эквивалентное логическому И (AND)&

Назначение
Символ 

операции
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ваться в одной схеме многократно. Прежде

чем начнется моделирование, список соеди-

нений схемы будет расширен с заменой каж-

дого обращения к макромодели элементами

схемы из описания макромодели. Нет ника-

ких ограничений по размеру или сложности

макромоделей.

Описание макромодели должно заканчивать-

ся директивой .ENDS. Для удобства работы

с текстовым файлом в дальнейшем целесооб-

разно строку дополнить именем макромодели.

Пример использования макромодели:

*

* Описание схемы

X1 a b 0 divider

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

* Описание макромодели

.subckt divider n1 n2 n3

r1 n1 n2 1k

r2 n2 n3 1k

.ends

.tran 3μ

.end

Расширение после запуска моделирования:

* Расширение X1 до набора из двух резисторов

r:1:1 a b 1k

r:1:2 b 0 1k

*

v1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

.tran 3μ

.end

Отметим, что для элементов схемы, обра-

зованных расширением макромодели, созда-

ны уникальные имена, основанные на име-

ни макромодели и именах элементов описа-

ния макромодели.

.TEMP — температурный анализ

Это устаревшая форма для команды сту-

пенчатого изменения температуры. Все ви-

ды анализа выполняются для каждой указан-

ной температуры.

Синтаксис:

.TEMP <температура1> <температура2> ...

Что эквивалентно:

.STEP TEMP LIST <температура1> <температура2> ...

.TF — определение 

малосигнальной передаточной функции

по постоянному току

В этом режиме определяется малосигналь-

ная передаточная функция по постоянному

току для узлового напряжения или тока вет-

ви при малых изменениях параметра незави-

симого источника. Параметры моделирова-

ния можно задать через диалоговое окно, по-

казанное на рис. 34.

Синтаксис:

.TF V(<узел>[, <опорный узел>]) <независимый источник>

.TF I(<источник напряжения>) <независимый источник>

Например:

.TF V(out) Vin

.TF V(5,3) Vin

.TF I(Vload) Vin

.TRAN — анализ переходных процессов

По этой директиве выполняется анализ пе-

реходного процесса. Это наиболее информа-

тивное моделирование схемы. В процессе ана-

лиза вычисляется, что происходит в схеме по-

сле подачи питания. В качестве испытательных

сигналов часто применяются независимые ис-

точники.

Синтаксис:

.TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers]

.TRAN <Tstop> [modifiers]

.TRAN <шаг вывода данных> <конечное время> [начальный момент

времени вывода данных [максимальный шаг]] [модификаторы]

.TRAN <конечное время> [модификаторы]

Первая запись представляет собой традици-

онную форму для SPICE команды .TRAN.

Tstep — шаг вывода графиков. LTspice исполь-

зует сжатие графиков, так что этот параметр

не имеет большого значения и может быть опу-

щен или установлен в ноль. Tstop — продол-

жительность моделирования. Анализ переход-

ного процесса всегда начинается с момента вре-

мени, равного нулю. Однако, если определено

Tstart, данные для графика между нулем и Tstart

не сохраняются. Это — средство управления

размером файлов графиков, позволяющее иг-

норировать переходные процессы при вклю-

чении. Последний параметр dTmax является

максимальным шагом интегрирования. Если

заданы Tstart или dTmax, то должен быть за-

дан и Tstep. Параметры моделирования легко

задаются с использованием диалогового окна,

изображенного на рис. 35.

В строку .TRAN могут быть помещены не-

сколько модификаторов из перечисленных

далее.

UIC

Использование начальных условий. Обыч-

но расчет рабочей точки по постоянному то-

ку выполняется перед началом анализа пере-

ходного процесса. Директива подавляет эту

инициализацию. Начальные условия для не-

которых элементов схемы могут быть опре-

делены случайным образом. UIC — не осо-

бенно рекомендуемая возможность SPICE.

Пропуск расчета рабочей точки по постоян-

ному току пункта ведет к нереализуемому фи-

зически начальному условию. Рассмотрим,

например, подключение емкости к источни-

ку напряжения. Узловое напряжение равно

нулю, если не задано иное. Тогда в первый мо-

мент бесконечный ток обязан заряжать кон-

денсатор. Симулятор не может найти доста-

точно короткий шаг времени и выдает сооб-

щение time step too small convergence fail.

STARTUP

Модификатор подобен оригинальному

SPICE UIC. Он означает, что независимые ис-

точники должны отключаться на первые

20 мс моделирования. Однако анализ рабо-

чей точки по постоянному току выполнен

с использованием ограничений, заданных ди-

рективой .IC.

STEADY

Останавливает моделирование по достиже-

нию установившегося режима. Это требуется

для создания отчета о расчете эффективности.

Обнаружение установившегося режима запи-

сано в макромоделях ВИП. Обычное реше-

ние — обнаружение нулевого значения в вы-

ходном токе усилителя ошибки, усредненном

по периоду тактовой частоты. Алгоритм пред-

полагает анализ выходного сигнала усилителя

ошибки. Доля импульсного тока, считающая-

ся нулевым током, задается параметром SSTOL.

Автоматическое обнаружение установив-

шегося режима может быть неудачным

вследствие неоптимального критерия его де-

тектирования. Можно в интерактивном ре-

жиме определить установившийся режим

следующим образом: как только моделиро-

вание начинается, выполните команду меню

Simulate>Efficiency Calculation>Mark Start.

При выполнении этой команды в первый раз

вы указываете LTspice, что собираетесь вруч-

ную определять пределы интегрирования.

После того как схема достигла установивше-

гося режима, выполните эту команду снова.

Это очистит историю и перезапустит расчет

Рис. 34. Задание параметров .TF/анализа

Рис. 35. Задание параметров .TRAN/анализа
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потерь. Затем, по меньшей мере через 10 так-

товых импульсов выполните команду Simulate>

Efficiency Calculation>Mark End. Каждый раз

при выполнении команды Simulate>Efficiency

Calculation>Mark Start повторно начинается

расчет потерь и очищается история графи-

ков. Это хороший метод воспрепятствовать

чрезмерному увеличению файла и замедле-

нию рисования. Рекомендуется периодичес-

ки выполнять Simulate>Efficiency Calculation>

Mark Start всякий раз, когда ясно, что накопле-

но существенное количество данных, которые

нецелесообразно включать в расчет потерь.

Используйте директиву .IC для определе-

ния узловых напряжений и токов через катуш-

ки индуктивности, чтобы уменьшить длитель-

ность анализа переходного процесса, предше-

ствующего установившемуся режиму.

NODICARD

Не удалять часть моделирования переход-

ного процесса, прежде чем будет достигнут

установившийся режим.

STEP

Расчет отклика схемы на ступенчатое воз-

действие. Эта функция работает с использо-

ванием в качестве нагрузки источника тока

со ступенчатым изменением тока. Процеду-

ра включает в себя следующие этапы:

1. Определяется установившийся режим

и очищается история, если не использует-

ся NODISCARD.

2. Нагрузка ступенчато изменяется к следу-

ющему значению из списка со скоростью

20 A/мкс.

3. Определяется установившийся режим.

4. Нагрузка ступенчато изменяется к следу-

ющему значению из списка или отключа-

ется, если его нет.

В сложной схеме автоматически изменение

тока нагрузки можно и не обнаружить. В по-

добном случае лучше использовать команду

.TRAN для запуска моделирования переход-

ного процесса и наблюдать начало и конец

периода желаемого отклика на скачок нагруз-

ки. Используйте команду PWL, чтобы про-

граммировать выходной ток нагрузки и пе-

реключать его на различные уровни в жела-

емые моменты времени. Например:

PWL(0 0.5 1m 0.5 1.01m 0.1 3m 0.1 3.01m 0.5)

Ток нагрузки начинается с 0,5 A в момент времени 0,

пребывает равным 0,5 A в течение 1 мс,

переключается на 0,1 A в момент времени 1,01 мс,

пребывает равным 0,1 A до 3 мс,

переключается на 0,5A в 3,01 мс и остается равным 0,5 A.

PWL может иметь почти неограниченную

последовательность пар (время, значение).

.WAVE —

запись выбранных узлов в .wav-файл

LTspice может записывать звуковые фай-

лы .wav. Эти файлы можно слушать или ис-

пользовать в качестве входных для другого

моделирования.

Синтаксис:

.wave <имя файла .wav> <Nbits> <SampleRate> V(out) [V(out2)

...]

Например: 

.wave C:\output.wav 16 44.1K V(left) V(right)

Здесь <имя файла .wav> — полный путь

к .wav-файлу или относительный путь, оп-

ределяемый из каталога, содержащего симу-

лируемую схему или список соединений.

<Nbits> — число битов в выборке. Допус-

тимый диапазон — от 1 до 32 битов.

<SampleRate> — количество выборок в се-

кунду. Допустимый диапазон — от 1 до

4 294 967 295 выборок в секунду. Далее в син-

таксисе — перечисление узловых напряже-

ний, значения которых нужно сохранить.

Каждый узел будет независимым каналом

в .wav-файле. Число каналов может быть от

одного до 65 535. Можно записать ток в уст-

ройстве, например, Ib(Q1), или узловое на-

пряжение. .wav-аналог цифрового преобра-

зователя имеет полномасштабный диапазон

от –1 до +1 вольта или ампера.

В файле …\LTC\SwCADIII\examples\Educa-

tional\wavein.asc приведен пример использо-

вания директивы .WAVE.

В следующей статье — примеры моделиро-

вания схем с использованием программы.   ■

www.kit5e.ru


